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IBM WebSphere® process integration 6.0.2 — Lab exercise

WebSphere Business Integration adapters —

Import and export
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What this exercise is about
The objective of this lab is to provide you with an understanding of how to use the WebSphere Integration
Developer V6.0.2 tools to generate the code used to communicate with WebSphere Business Integration

Adapters. You will also learn how to test the code using the integrated WebSphere Process Server V6.0 and
the test framework.

Lab requirements
List of system and software required for the student to complete the lab.
* WebSphere Integration Developer V6.0.2 installed
* WebSphere Process Server V6.0 test environment installed
» Sample code in the directory C:\Labfiles602 0Nind0ws®) or /tmp/LabFiles602 (Linux®)

* WebSphere Business Integration Toolset installed

What you should be able to do
At the end of this lab you should be able to:

» Generate the artifacts required to use a WebSphere Business Integration Adapter with WebSphere
Process Server

» Configure the adapter configuration files to be able to define how the adapter is to communicate with
the server

» Assemble the artifacts in an SCA wiring diagram

e Use the test framework to test both the outbound and inbound use of the adapters.
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Introduction

The following diagram highlights the parts of the overall scenario that will be addressed in this lab. You will
work on both the PeopleSoft and Siebel modules, but will only partially implement and test each of the
modules. The main focus will be converting existing Application Specific Business Objects (ASBOs) and
Connector configurations for PeopleSoft and Siebel so that they can be used with the WebSphere Process
Server. You will then test the ability to create a connection between the Visual Test Connector and WebSphere
Process Server for sending in a PeopleSoft ASBO and for sending out a Siebel ASBO.

e N

PeopleSoft
(VTC) @ Manual Clean
Module
ol /"—' (HTM)
Soft
SBQ
PeopleSoft Cleanse Publish Auto Clean
Adapter Module Module (POJO,
Module (BPEL or BSM) Selector, BR)

Siebel
ASBO

Siebel i
Adapter %\I;_bce)l >
Module
Flat
7 File
Flat File e ]
FlatFile
JCA Adapter :
Module (File system)

The process of converting the ASBOs and connector configuration is done using the Enterprise Service
Discovery tool. It takes as input the .xsd files that define the ASBOs and the .cfg file that defines the
connection between the WebSphere Business Integration Adapter and the existing broker. The following is
produced as output:

« .xsd files defining the ASBOs in a format used by WebSphere Process Server

» SCA Imports and Exports (or both) specifically configured for use with this adapter and these ASBOs

» SCA Interfaces used for Inbound and Outbound communication with this adapter with these ASBOs

* A properties file used to configure WebSphere Process Server to be able to communicate with this
adapter
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Description of the module
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The following two diagrams show the PeopleSoftAdapter and SiebelAdapter modules. They highlight the parts
of the modules that will be addressed in this exercise. The mediation and maps, which are used to convert
from PeopleSoft ASBOs to GBOs and from GBOs to Siebel ASBOs, will be added in a subsequent exercise.
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Business objects

The following business objects will be used in this exercise.

 Psft_ClipType — The parent business object describing characteristics of a particular clip.

 Psft_Retailltem — The child business object describing a retail packing option for this type of clip

« Siebel_ProductType — The parent business object describing characteristics of a particular type of
product

* Siebel_ProductPackage — The child business object describing a retail packaging option for this type of
product. .

All four of these business objects will be used both in their original format and in the format required for use
with WebSphere Process Server.

In addition to these business objects, there will be four business graphs generated to contain these business
objects.

 Psft_ClipTypeBG
 Psft_RetailltemBG

* Siebel_ProductTypeBG

* Siebel_ProductPackageBG

Although all four of these are generated by the tool, it is only the two associated with the parent business
objects that are needed. The business graphs for the child business objects are not used in the scenario.
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Interfaces

The following interfaces are generated by the Enterprise Service Discovery tool.

* InboundDelivery — Generated interface used to pass in a Psft_ClipTypeBG business graph from the
PeopleSoft adapter to an SCA component running in the server.

» OutboundRequest — Generated interface used to pass out a Siebel_ProductTypeBG business graph
from an SCA component running in the server to the Siebel adapter.

Exercise instructions

Some instructions in this lab might be specific for Windows platforms. If you run the lab on a platform other
than Windows, you will need to run the appropriate commands, and use appropriate files (for example .sh in
place of .bat) for your operating system. The directory locations are specified in the lab instructions using
symbolic references as follows:

<WID_HOME> C:\Program Files\IBM\WebSphere\ID\6.0 | /opt/IBM/WebSphere/ID/6.0

<WPS_HOME> <WID_HOME>\runtimes\bi_v6 <WID_HOME>/runtimes/bi_v6

<LAB_FILES> C:\Labfiles602 /tmp/Labfiles602

<WORKSPACE> | C:\Labfiles602\eXchange\WBIAdapters\ | /tmp/Labfiles602/eXchange/WBIAdapters
workspace /workspace

<TEMP> C:\temp ftmp

<SOLUTION> C:\Labfiles602\eXchange\WBIAdapters\ | /tmp/Labfiles602/eXchange/WBIAdapater
Solution s/Solution

Windows users’ note : When directory locations are passed as parameters to a Java  program such as
wsadmin, you must replace the backslashes with forward slashes to follow the Java convention. For example,
C:\LabFiles60\ would be replaced by C:/LabFiles60/.

Note that the previous table is relative to where you are running WebSphere Integration Developer. The
following table is related to where you are running remote test environment:
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<SERVER_NAME> serverl clisrol

<WAS_HOME> C:\Program /etc/clicell/AppServerNodel
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<BOOTSTRAP_PORT> 2809 2809

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrv0l default

<USERID> N/A clladmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/0S, AIX® or Solaris, can be found at the end

of this document, in the section “Task: Adding remote server to WebSphere Integration

test environment

2007 September, 14
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Part 1: Initialize the workspace for this lab exerc  ise

In this section of the lab, you will be importing a library project part of the CleansePublishLibrary Pl.zip project
interchange file into your workspace and eventually create two modules PeopleSoftAdapter and
SiebelAdapter.

1. Start WebSphere Integration Developer V6.0.2 with a workspace location of <WORKSPACE>, that
is <LAB_FILES>\eXchange\WBIAdapters\workspace

___a. From Windows Explorer, navigate to the <WID_HOME> directory and double click on wid.exe

___b. When prompted for workspace, enter the value provided by the <WORKSPACE> variable for
this lab and click OK

= Workspace Launcher |

Select a workszpace

IEM WebSphere Integration Developer stores wour projects in a directory called a workspace,
Select the workspace direckory ko use For this session,

ielarat=te -t B | abfilesc0l elkchange i WEIAdapter shworkspace j Browse. .. |

| ok I Zancel

___¢. When WebSphere Integration Developer V6.0.2 opens, click the curved arrow at top right to go
to Business Integration perspective

=

Integration Developer Go to the Business Integration perspective{::‘:_'r?u?)
e

___d. Ensure you are in the Business Integration perspective

2. Import Project Interchange file, CleansePublishLibrary _Pl.zip located at
<LAB_FILES>\eXchange\CleansePublishLibrary\import

___a. Right-click inside Business Integration View  (top left view in the Business Integration
Perspective) and select Import from the context menu

___b. Select Project Interchange listed in the import dialog
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+4= Import

Select
Import a project and its dependent projects from a Zip file, \“

Select an import source:

& Evisting Ant BuildFile
[ Existing Project inko Warkspace
[ File system
L HTTP
P', Project Inkerchange
&1 RAR fil
ﬂ"‘}, Server Configuration
Z wieb Service
WebSphere InterChange Server JAR File (I
\WebSphere MO Waorkflow FDL File
WebSphere Studio Application Developer Integration Edition Service Project ll

FE R e e ¢

[ show al

= Bach I Mext = I Fimish Cancel

___C. Click Next

___d. Click the Browse button for “From zip file ” and navigate to
<LAB_FILES>\eXchange\CleansePublishLibrary\import\C

hit Open

leansePublishLibrary Pl.zip and

#% Imporkt Project Interchange Contents

b

Import Projects

Import Projects from a zip file.
L -
15"
From zip File: I 1\ Labfilesc02hexchangel CleansePublishLibraryimport CleansePublisbLibrary_PLzip j Browse, ., |
Project location roak: I Ci\Labfilesc02Yekchange WEBLAdaptershworkspace Browse, ., |

I [¥]= CleanserublishLibrary

Select Al | Deselect Al | Select Referenced

< Back Mexk = | Finish I Zancel
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___e. Select the check box next to CleansePublishLibrary and click Finish

___f. Verify you have CleansePublishLibrary module listed in the Business Integration view

- Business Inkegration X =0

BeEeEHE -

CleansePublishLibrary

___g. Verify you have WebSphere Process Server V6.0 listed in your Servers view

Properties | Problems L Ly AR !

Server | Host name | Skatus | State
localhost l Skarted Synchronized

3. Create a new module named, PeopleSoftAdapter

___a. Right-click in Business Integration view and select New - Module from the context menu

" Business Integration X = Eq(
BEEHS -

CleansePublishLibrary

= Project...

Open Dependencies

Shiow Files 15 Mediation Module
W Copy & Module
B Faste (= Library
3 Delete [ Business Object
Refactor , £ Business Object Map

___b. Enter the Module Name as PeopleSoftAdapter
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4= New Module
Module
Create a new business integration module, & module is a project that is used For development, J__l
wersion management, organizing resources, and deploving to the runtime environment, | .-_’ /

Module Mame: | PeopleSoftadaptet|

Module Location
¥ Use default

Direchorns I CiLabfilese02)exchangel WEIadaptershmorkspacelPeopleSoftadapter Browse, |

¥ ©pen module assembly diagram

Business integration modules can be deployved and run on MebSphere Process Server, They can conkain many
byvpes of components, such as business processes, assembled bogether For the purpose of business
inteqgration.

= Back Mexk = | | Finish I Zancel

___C. Click Next

___d. In the following panel, select the check box next to CleansePublishLibrary . This adds the
CleansePublishLibrary as a dependant library for the ManualClean module

4= New Module

Select Hequired Libranes

Select libraries conkaining re-usable resources such as interfaces, to be used by this module, J__l

Librarigs:

CleansePublishLibrary

Module dependencies are primarily configured using the dependency editor.

< Back. Mexk = | | Finish I Zancel

___e. Click Finish

__f. Verify you have PeopleSoftAdapter module listed in the Business Integration view
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-

-
fz: Business Integration &3 =B
HeEeog ~

@ CleansePublishLibrary
[#- 1= PeopleSoftadapter

4. Create a another module named, SiebelAdapter
___a. Right-click in Business Integration view and select New - Module from the context menu
___b. Enter the Module Name as SiebelAdapter
___C. Click Next

___d. In the following panel, select the check box next to CleansePublishLibrary . This adds the
CleansePublishLibrary as a dependant library for the ManualClean module

___e. Click Finish

___f. Verify you have SiebelAdapter module listed in the Business Integration view

" Business Integration X =0
BEeREg -
#-T@ CleansePublishlibrary
-T2 PeopleSoftAdapter
(SRS b dapter
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Part 2: Generate artifacts required for using the a  dapter with WebSphere

Process Server
In this part, you will convert the PeopleSoft and Siebel business objects and configuration from the format used
with WebSphere InterChange Server to the format used by the WebSphere Process Server. This must be
done for any adapter configuration and business objects when you plan to continue to use the WebSphere

Business Integration Adapter with the EIS application but will start using the WebSphere Process Server as
the broker.

The process is done using Enterprise Service Discovery which is provided in WebSphere Integration
Developer. It takes the .xsd files, which define the ASBOs, and the .cfg file, which defines the connection
between the WebSphere Business Integration Adapter and the existing broker, as input. The following is
produced as output:

» .xsd files defining the ASBOs in a format used by WebSphere Process Server

e SCA Imports or Exports(or both) specifically configured for use with this adapter and these ASBOs

» SCA Interfaces used for Inbound and Outbound communication with this adapter with these ASBOs

» A properties file used to configure WebSphere Process Server to be able to communicate with this
adapter

In this lab you will generate and test the artifacts for the PeopleSoft adapter and then repeat the process
for the Siebel adapter. The following steps will lead you through the process.

Instructions for PeopleSoft

1. Access the Enterprise Service Discovery wizard to generate the artifacts that will be used with the
adapter for PeopleSoft.

___a. Right click on the PeopleSoftAdapter module in the Business Integration perspective.
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___b. Select New > Enterprise Service Discovery from the context menu

LE CleansePublishLibrary | |

BB ccplcsoftadapt—="=

-1 Siebeltdapter

[ Project. ..

Cpen Dependency Edikor
Show Files £ Mediation Module

1= Module

"
‘ Paste

1=, Library
[ Business Object

4 g;:l” = Business Object Map
% Business Process

g Import... ~ Business State Machine

3 Expart... £ Custom Yisual Snippet

2 | Refresh = Decision Table

9] Emulatar
=1” generate Documentation, ..

Test L4
Team

E":‘.‘Eé Enketprise Daka Discovery

ﬁ Enterprise Service Discovery

-IT':, Hurnan Task

Dramarkiac

___c. From the Enterprise Service Resource Adapter panel, select WBI Adapter Artifact Importer

= Enterprise Service Discovery

Select an Enterprize Service Resource Adapter

Select a resource adapher ko use ko discover a service,

s;\ﬁ‘ IEM WebSphere Service Registry and Repository

WEBI Adapker Artifack Imporker

Impark Resource Adapker, .. |

Arkifact imparker For a ‘WEI Adapter endpaink

< Bach I Mext = I Fimish Zancel |

___d. Click Next

2. Inthe following panel, identify the specific configuration and location of the business objects to be
discovered

___a. Inthe Configure Settings for Discovery Agent panel,

1) Click the Browse for Connector configuration file and locate PsftConnector.cfg file at
<LAB_FILES>\eXchange\PeopleSoft\ASBOs\PsftConnector .cfg
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2) Click the Browse button for Business object schema directory locate the directory named
ASBOs at <LAB_FILES>\eXchange\PeopleSoft\ASBOs

4= Enterprise Service Discovery

Configure Settings for Discovery Agent

Specify the properties ko initialize the resource adapter and the enterprise service discovery agent,

Cannector canfiguration File: * IC:'I,LabFiIESEEIE'I,EXchange'l,F'enpIESDFI:'I,.C'.SEOS'I,PSFI:CDnnectu:ur.u:Fg Browse, ., |

Business object schema directory | iiLabfilesa0z\erchange\PeoplesoftA5B0s Browse, .,

< Back I Mextk = I Fimish | Cancel

___b. Click Next
3. Pick the specific objects for PeopleSoft to be processed

___a. Inthe following Find and Discover Enterprise Services  panel, click the Run Query button on
to discover the PeopleSoft objects.

= Enterprise Service Discovery

Find and Dizcover Enterprize Services

To discover objects on the enterprise system, create a guery by pressing "Edit Query” and then IEi?

press "Execute Query”, Once discovered, press "add to import list" to specify the objects to be
imported,

CUEry!: -

I Business object name filker=*,3C4 Impark outbound interactions{Hub Request (send.. .Req  Edit Query..,

Execute Query |

Objects discovered by query:

| ------ i < Execute a query to populate this view with discovered objects, = Filker:. ..

Clear Filker
[0 Add bo impart lisk

Details, .,
Objects ko be imported;

[LEE §

Remove

=l
< Back I Mexk = Fimist | Zancel |

___b. Select the business objects you want to process listed in the Objects discovered by query text
area and click the Add to import list  button
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Objects discovered by query:
Filtet. ..

WSN Pt ClipType {hitp: has,ibrn, connfwebsphere/crossworlds (2002 BOSchemaPsft_ClipTypel

Clear Filker

Details. .,

L

O Add ko impart: lisk

L A N Lo e B

___c. The Compurgation Parameters Psft_ClipType dialog pops-up

4. In the Configuration Parameters for Psft_ClipType dialog, select the kinds of interactions you will
need between the adapter and the server. This will determine which interfaces will be generated for

the selected business objects. The choices you have are:

sendPsft_ClipTypeRequest — outbound requests from server to adapter with response

sendPsft_ClipTypeOneWay - outbound requests from server to adapter without response
« receivedPsft_ClipTypeRequest — inbound requests from adapter to server with response
« receivedPsft_ClipTypeDelivery — inbound requests from adapter to server without response

___a. Inthis lab scenario, you only need inbound requests from adapter to server without a response.
Therefore, ensure that only the check box next to receivedPsft_ClipTypeDelivery is checked,

as shown below:

+4= Enterprise Service Discovery

Configuration Parameters for Psft_ClipType {http://www. ibm_com/we

Set the configuration parameters, then press QF, "-.:_"'-«\
Configuration propetties

[T sendPsft_ClipTypeRequest
[ sendPsft_ClipTypetneiay
| ?Eu:eivedF‘sFt;IipTypeRequest?
F reu:eivedF‘sFt;IipTypeDelivery]

(04 I Zancel

___b. Click OK and you will see the object you had imported populated in the Objects to be imported
text area as shown below:
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= Enterprise Service Discovery

Find and Dizcover Enterprize Services

To discover objects on the enterprise system, create a query by pressing "Edit Query” and then press Iai?

"Execute Query", Once discovered, press "Add bo import list” o specify the objects to be imported,

CIuery:
I Business object name filker=*,5C4 Import outbound interactions{Hub Request (send. . .Requesti=true  Edit Query...

Execute Quety |

Chbjects discovered by query:
------ (0 Psft_ClipType {httpef fwnan,ibm. comfwebsphere fcrossworlds) 2002 (BOSchemaPstt_ClipType) Filter, ..

Clear Filker

O Add boimEart lisk Debails. ..

CObjects to be imported:
“ ------ Q) Psft_ClipType {http:f e, ibrn . comfwebsphere forosswaorlds/ 2002 /BOSchema)Psft_ClipType} Remove

EEE b

Cancel |

< Back I Mext = I Fimish

___c. Click Next

5. Save the generated artifacts. In the following Generated Artifacts panel, provide the following
information:

___a. Ensure Runtime business object format is set to BusinessGraph
___b. Ensure the Target project is set to PeopleSoftAdapter

___c. Enter wbia/asbo for folder

#% Enterprise Service Discovery

Generate Artifacts

Specify the properties for the artifacts that will be generated in wour Al
warkspace,

Runtime business object Format: IEusinessGraph j

Messaging engine: M5
Target praoject: IF‘eapIeSDFt.ﬁ.dapter j Mew, ., |
Folder: le:uia,l'asl:n:u Browse, ., |

< Back | Texh = | Finish I Zancel |
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___d. Click Finish

6. Examine the generated artifacts by expanding the PeopleSoftAdapter module tree in the Business
Integration view.

__a. Expand PeopleSoftAdapter -> Data Types. You will see four new business objects that provide
the WebSphere Process Server form of the two business objects which were defined for use with
the PeopleSoft adapter. For each of the adapters business objects, there is a business object
generated with the same fields and a business graph object that wrappers it. In this scenario
there is no need for the Psft_RetailltlemBG because the Psft Retailltem is contained within
Psft_ClipType and therefore does not require a business graph when passed across an interface

- Business Integration X

BEeEg -

-l CleansePublishLibrary
Ef’ﬂ PeopleSoftadapter
[+-g=) Assembly Diagram
----- ﬂ Dependencies
- £ Business Logic

= ---f:ﬁ" Data Types

b E7] Psft_ClipType

H 5

...... Psft_ClipTvpeBiG

~1-] Psft_Retailltern
- PsFt_RetailltermBa
-5 Interfaces

---o& Mapping

b T Events

-1 Sieheladapter

__b. Now expand PeopleSoftAdapter -> Interfaces . You will see the InboundDelivery interface. This
is the interface through which the Psft_ClipTypeBG will be passed into the server

- Business Inkegration T
#EeEE -
Lg CleansePublishLibrary
E@ PeopleSoftadapter
ﬁg] Assembly Diagrarm
..... ﬁ Dependencies
- & Business Logic
=4 Data Types
- 571 Psft_ClipType
- Psft_ClipTypeBi
071 Psft_Retailltern
[[5;] Psft_RetailltemBe
=2 Interfaces
- @ InboundDelivery
EIE
i T Events
- Sieheladapter
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__c. Expand PeopleSoftAdapter - Assembly Diagram . You will see the Export that is used to
define the interface and JMS data binding, which will be used by the adapter to communicate
with the server. You will notice that the PeopleSoftAdapter assembly is marked with an error as
the export is not yet wired to any SCA component, which is an invalid state for an Export. Later
in this exercise you will wire this Export to a component that supports the InboundDelivery
interface.

EIEE‘ PeopleSoftadapter

=] _Assermbly 0
i

7. Examine the properties file that was generated for you. The system will later use this file to configure
the server so that it can communicate with this adapter.

___a. From the main menu, obtain the Physical Resources view by selecting Window -> Show View
-> Physical Resources . Click OK on the warning dialog

| Windaw Help

Met Windo

Open Perspective k|

Shaw Yiew

Ll d = Business Inkegration

Customize Perspective... EE Cukline AlE+ShifE+C, O

save Perspective As... B Physical Resources
Reset Perspective

[%1 Problems AlE+Shife+C, #

Close Perspeckive

___b. In the Physical Resources view, expand PeopleSoftAdapter . Ensure the properties file,
PsftConnectorWsadmin.wbia you are looking for is listed. This contains information about the
gueues that are needed to configure the server to communicate with the adapter.

i~ -
Business Integration W

EEE

#-T@ CleansePublishLibrary

Elf_ﬂ' PeopleSoftadapter
-2 gen

(= META-TNF

--ﬁ} whia

.Classpath

..... .pruje-:l:

. FuCkime

----- PsFtConnectorysadmin, whia

-2 Siebeltdapter
+-1=2 websphere_default_messaging_provider

___c. If you would like to examine the property definitions, double-click on
PsftConnectorWsadmin.wbia and the file will be opened in the text editor.

8. Now return to the Business Integration view in the upper left panel by clicking on the Business
Integration tab at the top of the panel.
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Instructions for Siebel

In this section you will perform essentially the same steps that were done for PeopleSoft. The entire step by
step instructions will be provided, but without the extensive use of screen captures.

1. Access the Enterprise Service Discovery wizard to generate the artifacts that will be used with the
adapter for Siebel.

___a. Right click on the PeopleSoftAdapter module in the Business Integration perspective.
___b. Select New - Enterprise Service Discovery from the context menu

2. Inthe Enterprise Service Discovery panel, identify the specific configuration and location of the
business objects to be discovered.

___a. Select WBI Adapter Artifact Importer  in the Select an Enterprise Service Resource Adapter
panel

___b. Click Next
___c. Inthe following Configure Settings for Discovery Agent panel,

1) Click the Browse for Connector configuration file and locate PsftConnector.cfg file at
<LAB_FILES>\eXchange\Siebe\ASBOs\SiebelConnector.c fg

2) Click the Browse button for Business object schema directory locate the directory named
<LAB_FILES>\eXchange\Siebe\ASBOs

___d. Click Next
3. Pick the specific objects for Siebel to be processed.

___a. Click the Run Query button to discover the Siebel objects on the Find and Discover Enterprise
Services dialog.

___b. Select the business objects that you want to process in the Objects discovered by query  text
area.

___C. Click the Add to import list  button and you will be presented with the Configuration Parameters
for Siebel_ProductType dialog.

4. In the Configuration Parameters for Siebel_ProductType dialog, you select the kinds of interactions
you will need between the adapter and the server. This will determine which interfaces will be
generated for the selected business objects. The choices you have are:

» sendSiebel_ProductTypeRequest — outbound requests from server to adapter with response
» sendSiebel_ProductTyeOneWay - outbound requests from server to adapter without response
* receivedSiebel ProductTypeRequest — inbound requests from adapter to server with response

* receivedSiebel ProductTypeDelivery — inbound requests from adapter to server without
response

___a. Inthis lab scenario, only outbound requests from server to adapter with a response are needed.
Therefore, ensure that only the check box next to sendSiebel ProductTypeRequest is

selected.
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4= Enterprise Service Discovery

Configuration Parameters for Siebel ProductType {http:/fwww ibm.col

Set the configuration parameters, then press Ok, Y
Configuration properties

V¥ sendsiebel_ProductTypeRequest
[™ sendSiebel_ProductTypeoneiay
[ receivedsiebel ProductTvpeRequest
[ receivedsiebel_ProductTypeDelivery

| ok I Zancel

__b. Click OK

___C. Click Next

5. Save the generated artifacts. In the following Generated Artifacts panel, provide the following
information:

___a. Ensure Runtime business object format is set to BusinessGraph
___b. Ensure the Target project is set to SiebelAdapter
___c. Enter the name of the folder as wbia/asho

___d. Click Finish

6. Examine the artifacts that were generated for you by expanding the SiebelAdapter module tree in
the Business Integration view

__a. Expand SiebelAdapter -> Data Types and examine the generated business objects
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__b. Expand SiebelAdapter -> Interfaces . You will see the OutboundRequest interface. This is the
interface through which the Siebel_ProductTypeBG will be passed out to the adapter

__c. Expand SiebelAdapter > Assembly Diagram . You will see the Import that defines the interface
and the JMS data binding which will be used by the server to communicate with the adapter

=
Mhysical Resources |

BHeERDs -

'Lg CleansePublishLibrary
fé‘ PeopleSoftadapter
E:g Siebelddapker

: Assembly Diagram

- Dependencies
& Business Logic

L——_Iu'fi" Daka Tyvpes

E 7] Siebel_ProductPackage
e Siebel_ProductPackageBG

------ 7] Siebel_ProductType

o Siebel_Product TypeBG

=- ':?:' Interfaces
i @ CutboundRequest
[ & Mapping

----- I Ewvents

7. Examine the properties file that was generated for you. The system will later use this file to configure
the server so that it can communicate with this adapter

___a. Obtain the Physical Resources view in the upper left panel by clicking on the Physical
Resources tab at the top of the panel

___b. In the Physical Resources view, expand SiebelAdapter . Ensure the properties file,
SiebelConnectorWsadmin.wbia you are looking for is listed. This contains information about
the queues that are needed to configure the server

___c. Double click on SiebelConnectorWsadmin.wbia if you want to examine the definitions

8. Return to the Business Integration view in the upper left panel by clicking on the Business
Integration tab at the top of the panel

9. Save all work by File - Save All or Crtl + Shift + S

2007 September, 14 IBM WebSphere process integration 6.0.2 — Lab exercise Page 21 of 46

WPSWIDv602_eXcLab_WBIAImportExport.doc



© Copyright IBM Corporation 2007. All rights reserved

Part 3: Configure the connector configuration files

The PeopleSoft and Siebel adapters make use of a connector configuration file to define the configuration of
the broker they will be communicating with. You already have the connector configuration files that were
defined for use with a broker other than WebSphere Process Server. You used these configuration files when
you ran the Enterprise Service Discovery earlier in this exercise as it provided information that was used to
create the properties file that is used to configure WebSphere Process Server. There are some modifications
that must be made to these files in order for the adapters to communicate with WebSphere Process Server. In
this part you will examine these modifications. The modified connector configuration will be used in later parts
to allow the Visual Test Connector to communicate with WebSphere Process Server to simulate the
PeopleSoft and Siebel adapters.

1. Start the Connector Configurator (this could vary for different versions of Windows — the instructions
provided are consistent with Windows XP)

__a. From the start menu, select All Programs -> IBM WebSphere Business Integration Adapters
- IBM WebSphere Business Integration Toolset - Connector Configurator

2. Open the original connector configuration file for PeopleSoft which was used with the previous
broker

__a. Select File > Open - From File... in the Connector Configurator

¥zl connector Configurator [_ (O]
File Edit “iew Help

Mew s I | % S 2| Tarnet Sustem: [Wind W
From File... Chrl+I

Zlmse -
Conneckor-3pecific Property Template, ..

Clmse Al

Save b

Save hs

]
Save Al p peument [ A

___b. The Open File Connector pops-up. Navigate to <LAB_FILES>\eXchange\PeopleSoft\ASBOs
and select PsftConnector.cfg file

K E3

Open File Connector

Look in: | 5 4SBOs <] « & ok B

PsftConnector.cfg
m PsftConnectorwPs.cfg

File name: IF'sftI:nnnectnr.cfg Open I
Filzz of type: I Configuration [*.cfg) j Cancel |
Help |
A4
___C. Click Open
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3.  Now open the connector configuration files for PeopleSoft which will be used when communicating
with WebSphere Process Server

___a. Select File > Open - From File... in the Connector Configurator

___b. When the Open File Connector pops-up, navigate to
<LAB_FILES>\eXchange\PeopleSoft\ASBOs and select PsftConnectorWPS.cfg file

Open File Connector Ed

Look in: | [ 4SBOs x| « & cF E-

m PsftConnectar,cfg

File name: IF'sftl:DnnectDrWP'S.cfg Open

Filez of type: II:aniguratinn [*.cfg) j Catizel

Help

Pl

A

___C. Click Open
4.  Arrange the two connector configuration files that you opened, so they can be viewed together

___a. From the main menu, select Window -> Tile in the Connector Configurator

File Edit Wiew | window Help

O ﬁ Cascade
:
e s Arrange Icons

m 1 'Wa5 - PsftConneckor

E Standan o 2 WAS - PsftConnectorPs

5. Examine the key fields in the Connector Configuration files to see which values needed to be
updated based on your environment so that the adapter can connect to WebSphere Process Server

___a. BrokerType - The broker type must be set to WAS
|6 [BrokerType | - |

___b. jms.MessageBrokerName — The name of the message broker must be
WBIA_QM:WBIA.JMS.SVRCONN:<HOSTNAME>:5558

| 15 |jms MezzageBroketame MBS CAWBLS JMS SWYRCOMNM: localhost:

Note: localhost: 5558 assumes that (1) the adapter and WebSphere Process Server are running on the
same machine and (2) the server has been configured with the default port assignments. These must be
the WebSphere Process Server host name and the configured SIB_MQ_ENDPOINT_ADDRESS.
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___c.jms.UserName and jms.Password — This is the user name and password used to authenticate
for IMS communication with WebSphere Process Server

EEEEEELS

17 |im=.Password
18 |jm=.U=zerMName anything

Note: In this case, WebSphere Process Server is not secured and therefore you do not need a valid
username and password. However, the values cannot be left blank or errors will occur.

___d. RepositoryDirectory — The repository directory must point to where the business objects used
by the adapter are located, in this case <LAB_FILES>\eXchange\PeopleSoft\ASBOs

|24 |Repu:us'rtu:ur‘:.-‘Direu:tu:ur':.f |C:WLabfiIesE;ElEEKchangeﬁPeupleSnﬂL&SBOS |

6. If updated the connector files, from the main menu select File - Save All - To File to save the
changes

7. Now open the connector configuration files for Siebel which will be used when communicating with
WebSphere Process Server

___a. Open the following two files in the Connector Configurator:

<LAB_FI LES>\ eXchange\ Si ebel \ ASBCs\ Si ebel Connect or. cfg
<LAB_FI LES>\ eXchange\ Si ebel \ ASBCs\ Si ebel Connect or WPS. cf g

___b. Compare the values for the following fields

Br oker Type: WAS
j ms. MessageBr oker Nane: WBI A QMt WBI A. JMS. SVRCONN: <HOSTNAME>: 5558

j me. Password; ****x*

j ms. User Nane: anyt hi ng
RepositoryDirectory : <LAB FILES>\ eXchange\ Sei bel \ ASBCs

___C. Save the changes
8. Close the Connector Configurator window

__a. From the main menu, select File - Exit
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Part 4: Assemble and test the PeopleSoftAdapter mod

In this part you will open the Assembly Editor for the PeopleSoftAdapter module. Using the Component Test
capability in WebSphere Integration Developer and the Visual Test Connector, you will test the Export to

ensure it can be used to receive a business object from the adapter.

2007 September, 14

___a. Expand PeopleSoftAdapter

szembl

Diagram (&

1. Open the PeopleSoftAdapter in the Assembly Editor

in the Business Integration view and double click on Assembly

FAEREIE to open it in an Assembly Diagram editor

___b. In the Assembly Diagram Editor, you will see a message that there is a new element in the
module and see an error indicator at the lower left of the PsftConnectorDeliveryHub. This is
because the PsftConnectorDeliveryHub does not have anything wired to it to send output. You
will fix this in subsequent steps

= P

% ﬁ*‘; PsftConnectorDeliveryHub

The Test Component cannot examine the data coming in through an Export unless the Export is
wired to something. Therefore, you need to create a component that the Export can be wired to. To
do this, the component must support the same interface as the Export. However, the component
does not need to be implemented and the test component will emulate its operation. This setup
enables you to examine the business graph sent in from the Visual Text Connector through the

Export.

___a. Inthe Business Integration view, expand PeopleSoftAdapter

___b. Drag the InboundDelivery

interface to the assembly editor canvas

- Interfaces

mmﬂsical .

# =

T v (IFh

'[g leansePublishLibrary
=i Peoplesoftadapter
ﬁgl Assemnbly Diagram
10 Dependencies

#- (= Business Logic

- J= Data Types

) Interfaces

: = @ InboundDelivery
- & Mapping

o ¥ Ewvents

[+-3= Sisbelddapter
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___¢. Onreleasing the mouse button to drop it on the assembly editor, you will see the Component
Creation dialog pop-up

+4% Component Creation |

Select the type to create:

- Component with no Implementation Type
* Excpart with no Binding
iﬁ!' Export with Web Service Binding
= Impart with na Binding
-E‘_)Impcurt with Web Service Binding

K, I Cancel

___d. From the Component Creation dialog, select Component with No Implementation  Type and
click OK. The assembly editor should now look similar to the following screen capture:

et

= Al E]
'% & peftConnectorDeliveryHub (1) 'E Companent1

___e. Wire the Export to the unimplemented Component
1) Click on the Export PsftConnectorDeliveryHub and drag a wire to Componentl

2) Your Assembly Editor should now look something like the picture below:

ey A @
'%', &b peftConnectorDeliveryHub '*i". ek Companent 1

__f. Save all work by File > Save All or Crtl + Shift + S

Note: There must not be any errors reflected in the Problems view at this time.

3. Add the PeopleSoftAdapter module to the WebSphere Process Server Test Environment

___a. From the Server view, right click on WebSphere Process Server V6.0 and select Add and
Remove Projects... from the context menu

___b. Inthe Add and Remove Projects dialog, select only the PeopleSoftAdapterApp project from the
Available projects panel
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___c. Click Add > to add it to the Configured projects panel

4= Add and Remove Projects

Add and Remove Projects

Maodify the projects that are configured on the server ‘ ‘

Move projects ko the right bo configure them on the server

fvvailable projecks: Configured projects:
-7 Siebeladapterapp #-1H PeopleSoftadapterspp
add > |
= ReEmove |
add Al ==
<< Remove All |

< Back Mexh = | Einish I Zancel

___d. Click Finish. If using a local testing environment, the server automatically starts if it is not started
at this time

If using a remote testing environment, follow the directions provided in Task: Adding Remote
Server to WebSphere Integration Developer Test Envi __ronment (at the end of this document)
to restart a server

4.  Connectthe Visual Test Connector (from now on VTC) to the WebSphere Process Server test
environment. Using the connector configuration at
<LAB_FILES>\eXchange\PeopleSoft\ASBOs\PsftConnector ~ WPS.cfg follow the instructions
below to use the Visual Test Connector:

___a. Ensure the WebSphere Process Server is active (the server is the IMS Broker). The VTC
requires an active JMS Broker to start its connection

___b. Start the Visual Test Connector

__c. From the start menu, select Programs - IBM WebSphere Business Integration Adapters >
IBM WebSphere Business Integration Toolset - Visual Test Connector . This opens a
command window in the background where the process runs and the Visual Test Connector
Interface in the foreground. Do not close the command window as this will cause the VTC to exit
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___d. From the main menu of the VTC interface, select Create/Select a Profile . The Connector Profile
panel opens

::ijfﬁ!": Test Connector
File Edit Request Help

ck Profile. .. kel

'%'. Conmeck CErl-A

Exit

___e. Create a new PeopleSoft profile by selecting File - New Profile... from the main menu of the
Connector Profile panel

Bl Connector Profile
File Edit

w Profile, . CErl4-M

Exit
___f. Enter the following information in the New Profile panel:

1) Click the Browse button for “Select the connector configuration file:” filed and select
<LAB_FILES>\eXchange\PeopleSoft\ASBOs\PsftConnector WPS.cfg file

2) Connector Name : PeopleSoft
3) Broker Type : WAS

Mew Profile | x|

Select the conneckor configuration File:

IC:'I,LaI:uFiIes6EIE'I,EX::hange'l,F‘eu:upleSnFt'l,.ﬁ.SEOS'I,F'sFtC-:unne-:I:Dr'-.-'-.-'F' Browse |

—Conneckor

Conneckar Mame I PeopleSaft

Broker Tvpe I'-.-'-.-'.ﬁ.S j

—Server

Server I

User ID I

Passward I

I Cancel

__g.Click OK

___h. Select the PeopleSoft profile you had created as shown below:
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B Connector Profile
File Edit

ﬁblﬁl % |

Conneckar | SEFVEr | Iser ID | Configuration File

Peoplesoft

Ik Cancel

__i. Click OK

__j. Now in the Test Connector interface, select File > Connect from the main menu

:;._;:_._ Test Connector -[¥WAS] - [Peoplesoft]
| File Edit Reguest Help
& Create/Select Profile. .. k-1

Connect

Exit

___ k. Ensure that a successful connection is made. You can confirm this by watching the trace
messages displayed at the bottom frame of the Test Connector interface as shown below:

Test Connector -[WAS] - [Peoplesoft]

File Edit Request Help

H e l 8|5 R =

Business Cbjsct Tvpe I j Business Object Request Lisk
Business Object Instanu:el j Create |
Business Object Editar
Werb: I "’I Business Cbject Locale; Ien vI
Mame | Type | Yalue |
Connecking ko Was, ., Thursday, March 22, 2007 9:22:54 AM 5T ;I
reupleSnFt Ready Thursday, March 22, 2007 22:56 AM ST
4] o

FenpleSDFt Ready
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5. Inthe WebSphere Integration Developer, attach the test component to the PeopleSoftAdapter
module

__a. Inthe Business Integration view, right click on the PeopleSoftAdapter and select Test >
Attach from the context menu. The PeopleSoftAdapter Test Component editor opens

___b. Click on the Configurations tab at the bottom of the Testing Module: PeopleSoftAdapter
view. You should see something like in the following image:

%) Assembly Diagram: PeopleSoftadapter *PeopleSoftAdapter Test 8

Configurations

----- &rd” whia/asbofPsftConnectorDeliveryH.

Configurations ¢ General Properties
(SRS =<t Confiouration Defaul Module Test = Detailed Properties
El---guh%d::uT:tszSufmdapter Modules included in this test configur ation:
. eip ] Componenti 5 PeopleSoftAdapter
E%} Manitors

Load...

Login properties
User ID: | <No user = |

1| |

Event Cunl‘iguratiu:unsl

___¢. Notice that Componentl is listed under the Emulators . This means that Componentl, which is
not implemented, will be emulated when it is called. This will allow you to see the business graph
that results from the input from the Visual Test Connector.

__d. Notice that PsftConnectorDeliveryHub.<export> -> Componentl is listed under Monitors. This
means that anything that flows over that wire will result in an event which can then be
interrogated to see what passed through the wire.
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___e. Click on the Events tab at the bottom of the Testing Module: PeopleSoftAdapter  view. You
should see something like the following screen capture. This is where the results will be shown
when the application is invoked.

-
?.5’1 Assembly Diagram: PeopleSoftAdapter

Events
Events ¢ General Properties
------ i « Detailed Properties

Configuration: |Default Module Test |E|

Module: PeopleSoftAdapter

Events Configurations

___f. Click Continue

___g. Select the WebSphere Process Server V6.0 server in the Choose a deployment location
dialog
4= Deployment Location

Select Deployment Location

This server instance is currently running. ” [: B>

Deployment location:

E-=g “WebSphere Process Servers Mew Server. ., |

Sphere Pro

Maode: IRun j

[ Use this as the default and do not ask again

___h. Click Finish
6. Load a predefined business object into the Visual Test Connector

___a. Inthe main menu of the Visual Test Connector interface, select Edit - Load Business Object
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s Test Connector -[WAS] - [PeopleSoft]
File | Edit Feguest Help

___b. Inthe Open dialog, navigate to <LAB_FILES>\eXchange\PeopleSoft\ASBOInstances

select PsftASBO1.bo

___C. Click Open

___d. Inthe New Instance dialog, enter the name to be assigned to this instance as Psftl

___e. Click OK

7. Review the datainthe b

___a. Review the values assigned to the Business Object, Psft_ClipType

58 Bl Create Business Ohject (ZhElHk

— q?! Reset Business Objeck Zhe[+E

Busi & Clear Business Object hrl+F

Busi e Delete Business Object Chr| D
B

% Load Business Object Chrl+L

WE
Save Business Object ChFH-S

f
5 Compate Business Objects k45

MNew Instance | x|
Enter Mame I Psft1|

(04 I Cancell

usiness object

___b. Expand RetailUnits[n] to expand the Psft_Retailltem array

___¢. Expand [0] to view the instance of Psft_Retailltem
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Business Objeck Tyvpe IF‘sFt_CIipT*;.-'pe j
Business Objeck InstancelF‘sFtl j Create |
—Business Chject Editar
‘erb: ICreate vI Business Object Locale: Ien "I
Mame | Type | Yalue |
ClipID Skring CID1 2345
Clip Skring clasp
Size Skring small
Color Skring black,
[EREF: 2taillinits[ n Psft_R.etaillkern
[=I[o] Psft_Retailltem
ItemCode  String Q3765
Package Skring b
Cuantiky Skring 40
Price Skring 2,59
Available,..  String 2005-03-01
withdraw, .. Skring 2010-06-30
OwningC... | Skring Jones, 5am

ObjectEwv...  String
ObjectEventId Skring

8. Send the business object to the server

___a. From the main menu of the Visual Test Connector, select Request - Send

::._:j'"' Test Connector -[WaAS] - [Peoplesoft]
FEile Edit | Request Help

5] & B Edit Response iZhr|+R,

|H| ISinRss -'H Send ChH+T

9. Review the resultant business object in the server test component

___a. Inthe Events panel, you should see the Emulate of Componentl, indicating it is being called at
the receivedPsft_ClipTypeDelivery  operation

-
'1_:'& Azzembly Diagram: PeopleSaftadapter

Events

% Enter the values ba return Far this erolation, Click, Conkinue ta run,
Events

Elf;é= attach {Default Module Tesk)
=T Session

' L] Request {whia/asbo/PsfConnectorDeliveryHub - = Component :receivedPsf

e "F"]} Emulate {Componentl:receivedPsfit_ClipTypebelivery)
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___b. If the Emulate is not highlighted, click on it so that the input parameter to the method is displayed
on the right side of the panel

Input pararmekers

Mame | Type | Yalue -
[=|Psft_ClipTypeBcElement  Psft_ClipTypeBa
verb YerbTyvpe Create
=l Psft_ClipType Psft_ClipTvpe
lipID CliplDType CID12345
Clip ClipType clasp b
Size SizeType small
Color ColorType black,
[=] retaillnits Psft_Retailltem [ ]
[=] Retaillnits[0] Psft_Retaillkem
ItermCode ItemnCodeTwpe Q3765
Parkanes ParkansTwre Fire x
< | _>|_I

___c¢. Examine the values on the input parameter (scroll down as required). The data field values
should match those sent in from the Visual Test Connector

___d. Notice that there are no Output parameters because you generated your PeopleSoft adapter to
use the input with no response operation.

___e. Click the Continue button to complete the transaction
___10. Stop and close the test component
__a. Click the Stop () icon at the top right of the Events pane
___b. Close the PeopleSoftAdapter_Test component editor
___C. Click No in the Save Resource dialog
_____11. Close the Visual Test Connector
___a. Select File - Exit inthe VTC interface
___b. Select Yes in the Shutdown dialog
___c. Press Enter key In the Visual Test Connector command window to close it

12. Remove the unimplemented component that is the Componentl . It is not needed in subsequent
labs

___a. Inthe WebSphere Integration Developer, expand PeopleSoftAdapter in the Business

Integration view and double click on Assembly Diagram ("_41._\:| Asseinb

Assembly Diagram editor

FANREIE) to open it in an

___b. Right click on Componentl and select Delete from the context menu

___C. The resultant Assembly diagram looks like the following screen capture:

© & peftConnectarDeliveryHub

__d. Save all work by File > Save All or Crtl + Shift + S
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___e. Close the Assembly Diagram

13. Remove the PeopleSoftAdapter module from the WebSphere Process Server test environment

___a. Right click on WebSphere Process Server V6.0 from the Server view and select Add and
Remove Projects... from the context menu

___b. Select the PeopleSoftAdapterApp project from the Configured projects list
___C. Click < Remove

___d. Click Finish
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Part 5: Assemble and test the SiebelAdapter module

In this part you will open the Assembly Editor for the SiebelAdapter module. Using the Component Test
capability in WebSphere Integration Developer and the Visual Test Connector, you will test the Import to
ensure it can be used to send a business object to the adapter.

1. Open the SiebelAdapter in the Assembly Editor

___a. Inthe WebSphere Integration Developer, expand SiebelAdapter in the Business Integration

TR ) to Open it in an Assembly

view and double click on Assembly Diagram (-'q;j A
Diagram editor

___b. In the Assembly Editor, you will see a message that there is a new element added to the module.
This is the Import that was generated using Enterprise Service Discovery in a previous part of
this lab.

@ % SiebelConnectorfgent

2. Add the SiebelAdapter module to the WebSphere Process Server test environment

___a. Right click on WebSphere Process Server V6.0 from the Server view and select Add and
Remove Projects... from the context menu

___b. Select only the SiebelAdapterApp project from the Available projects panel
___c. Click Add > to add it to the Configured projects panel

___d. Click Finish

3. Connect the Visual Test Connector to the WebSphere Process Server test environment. Using the
connector configuration at <LAB_FILES>\eXchange\SiebeNASBOs\SiebelConnectorWP  S.cfg
and follow the instructions below to use the Visual Test Connector:

4. Ensure the WebSphere Process Server is active (the server is the JMS Broker). The VTC requires
an active JMS Broker to start its connection.

___a. Ensure the WebSphere Process Server is active (the server is the IMS Broker). The VTC
requires an active JMS Broker to start its connection

b. Start the Visual Test Connector

c. From the start menu, select Programs - IBM WebSphere Business Integration Adapters >
IBM WebSphere Business Integration Toolset - Visual Test Connector . This opens a
command window in the background where the process runs and the Visual Test Connector
Interface in the foreground. Do not close the command window as this will cause the VTC to exit

d. From the main menu of the VTC interface, select Create/Select a Profile . The Connector Profile
panel opens

e. Create a new Seibel profile by selecting File - New Profile... from the main menu of the
Connector Profile panel

___f. Enter the following information in the New Profile panel:
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1) Click the Browse button for “Select the connector configuration file:” filed and select
<LAB_FILES>\eXchange\Siebe\ASBOs\SiebelConnectorWP  S.cfg file

2) Connector Name : Siebel
3) Broker Type : WAS

New Profile Ed

Select the connector configuration File:

I C:1Labfilesa021exchange)SiebellASEOs SiebelConnectori'PS. . Browse |

—Conneckar

Conneckor Mame I Seibel

Broker Type I'u'u'.ﬂ.S j

—Server

Server I

User ID I

Passwiord I

Ik Cancel

__g.Click OK
___h. Select the Seibel profile you had created as shown below:

B Connector Profile
File Edit

w|Z| |

Conneckar | Server | ser ID | Configuration File |
PeopleSoft Z:Labfiless02 ek change\Peoplesaf. .,

Siebel Z:Labfiles ichange\Siebell A3E. .

Ik Zancel

__i. Click OK
__j. Now in the Test Connector interface, select File - Connect from the main menu

___ k. Ensure that a successful connection is made. You can confirm this by watching the trace
messages displayed at the bottom frame of the Test Connector interface as shown below:
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Test Connector -[WAS] - [Seibel]
File Edit Request Help

HEH el D E R

Business Object Type I

Business Chject Instancel j Zreate |

Business Object Editar

Werb: I vI Business Object Locale: Ien "’I

Mame | Type | alue |

j Business Object Request Lisk

Connecting ko Was, ., Thursday, March 22, 2007 10:43:17 &AM C5T ;I
Seibel Ready Thursday, March 22, 2007 10:43:19 AM CST

i i

|Sei|:ue| Ready |

5. Inthe WebSphere Integration Developer, expand SiebelAdapter in the Business Integration view

ssembl

and double click on Assembly Diagram ('?an -
editor

FANREIE) to open it in an Assembly Diagram
___a. Right click on the SiebelConnectorAgent import in the Assembly editor and select Test
Component from the context menu. The SiebelConnectorAgent test component editor opens
6. Enter the following values for Initial Request parameters:
___a. verb: Select Create from the drop down list
___b. Description : small black clasp

___c. Right click on ProductPackages and select Add element from the context menu

Initial request parameters

Marme | Tvpe
[=] siebel_ProductTypeEiElem...  Siebel_ProduckTypeBc:
werh skring
=l siebel_ProductType Siebel_ProductTvpe
Key skring
Descripkion skring

e Set Walue,..

delta &dd Element
locale

___d. Enter 1 for the “Number of New Elements to Add” in the New Element dialog

2007 September, 14 IBM WebSphere process integration 6.0.2 — Lab exercise Page 38 of 46

WPSWIDv602_eXcLab_WBIAImportExport.doc



© Copyright IBM Corporation 2007. All rights reserved

4= Add Element

Enter the number of new elements to add:

|1

Ik I Cancel

___e. Now enter the following values or of your choice under ProductPackages
1) Globalldentifier: 12345678901234
2) PackageDescription: box 40
3) Price: 2.59
4) AvailabilityStart: 2007-03-23
5) AvailabiltyEnd: 2010-06-30

6) Contact: Sam Jones

Initial request parameters

E= | Type | alue :l
Kenw skring
Descripkion skring small clasp black,

Siebel ProductPackage
[=IProductPacka...  Siebel_ProductPackage

[=EFroductPackages

|

Globalldenfier  string 12345675901 234
PackageDe,..  string bz 40

Price string 229
Availability...  string 2005-03-01
Awailability...  string 2005-06-30
Zonkack skring Sam Jones

VEFSinm Frker

<
Drata Poal Continue

7. Run the test

il

___a. Click the Continue button
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___b. Select the WebSphere Process Server V6.0 server in the Choose a deployment location

dialog
#* Deployment Location
Select Deployment Location
This server instance is currently running. ” I:IE’
- =7
/

Deployment location:

[=-Eg WebSphere Process Servers Mew Server..,

Mode: IRun j

™ Use this as the default and do not ask again

___C. Click Finish

___d. Review the Visual Test Connector window to see if a message has been received

:;ijfﬁ!'* Test Connector -[WAS] - [Seibel]

File Edit Reguest Help

HE} el D E B

I j Business Object Request Lisk
Siebel_ProductTvpe. Create

Business Object Tvpe

Business Object Instancel j Creake |

Business Object Editor

Yerh: I 'I Business Ohject Locale: Ien 'I

Mame | Type | Yalue |
A ———————————
Connecking bo WAS. .. Thursdaw, March 22, 2007 10:43:17 aM 5T ﬂ

Seibel Ready Thursday, March 22, 2007 10043:19 aM CST
dFleceived Business Object Siebel_ProductType Thursday, March 22, 2007 11:01:06 &M CST

< o

|Sei|:-e| Ready |

___e. Double click on Siebel_ProductType.create in the Business Object Request List to view the
business object received by the Visual Test Connector
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___f. The business object should look like this:

Bl Response Business Objeck
&9 7| @

Business Qbject Typel Siebel_ProductType

Werb: ICreate VI Business Object Locale: I "’I

Marme | Type | YWalue |
Fey Skring
Drescripkion Skring zmall black clasp
| ProduckPack. ., | Siebel ProductP. ..
[=1[0] Siebel_ProductP. ..
aloball,.. String 1234567590123534
Packa... String bz 40
Price: Skring 2.59
Bevaila,,.  Skring 2007-03-23
Bvaila.,.  Skring 2010-08-30
Conktact  Sbring Sam Jones
Chbijeck...  String CxCammon, BusinessObjecti@1 06, ..
ObjectEventId  String CxCammon, BusinessObject@1 06, .,
(04 | Zancel |

8. Stop and close the test component

___a. Click the Stop () icon at the top right of the Events pane

___b. Close the SiebelConnectorAgent_Test component editor

___C. Click No in the Save Resource dialog
9. Close the Visual Test Connector

___a. Select File - Exit In the VTC window

___b. Select Yes in the Shutdown dialog

___C. Click the Enter key In the Visual Test Connector command window to close it
____10. Clean WebSphere Process Server test environment

___a. Right-click on WebSphere Process Server V6 from the Servers view and select Add and
remove projects... from the context menu

___b. Click << Remove All
___c. Click Finish
____11. Stop the Server
___a. Right click on WebSphere Process Server V6.0 server from the Servers view and select Stop

from the context menu
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What you did in this exercise

In this chapter you started with configuration information and business object definitions used with a
WebSphere Interchange Server and PeopleSoft and Siebel adapters. You used the Enterprise Service
Discovery tool to do the conversions required to allow the adapters to be used with the WebSphere Process
Server. Using a properties file generated from ESD, you configured the WebSphere Process Server to have
the queues required for communication with the adapters. Using the Export and Import generated from ESD,
you constructed wiring assemblies for the two modules. Finally, using the Test Component and the Visual Test
Connector the modules were tested.
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Solution instructions

1. Follow the directions in the task Initialize the Workspace for a Lab Exercise, using the following
values:

<WORKSPACE>
C:\Labfiles602\eXchange\WBIAdapters\workspace
<PROJECT_INTERCHANGE>
C:\Labfiles602\eXchange\WBIAdapters\Solution\ImportExport_Pl.zip
<MODULE>
n/a
<DEPENDENT_LIBRARIES>
n/a

2. Continue from Part 4: Assemble and Test the PeopleSoft Module
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Task: Adding remote server to WebSphere Integration Developer test
environment

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.
The sample you will use is a z/OS machine.

Create a new remote server.
1. Right click on the background of the Servers view to access the pop-up menu.

2. Select New = Server.

- =
Properties | Problems m\tmﬁnlq L CUR =B

Server | Host name | Status I State
ﬁiﬁfehSphere ESE Server v&.0 localhost E‘E\ Stopped Synchronized
'n"'.n'el:uSphere Process Server va.0 localhost E_|E‘ Stopped Synchronized

" server |

3. Specify host name to the remote server, <HOSTNAME>.
4. Ensure that ‘WebSphere Process V6.0 Server ' is highlighted in the server type list.

x|

Define a New Server

Choose the type of server to create,

Specify the host where you want to publish

Le

Host name: Imvs:-:xx.rtp.raleigh.il:lm.cc.ml

Select the server type:

E-F= IBM

- ﬁ WebSphere ESB Server va.0
WebSphere Express v5.0 Server
ﬁ WebSphere Express w5, 1 Server
5ol WebSphere Process v6.0 Server
LB ehGnhere w5 Server Atach

LI+

View By: | Vendor

Ledle

Description: WebSphere Process v&.0 Server

5. Click Next.
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. Onthe WebSphere Server Settings page, select the radio button for RMI and change the ORB
bootstrap port to the correct setting (<KBOOTSTRAP_PORT>).

x|
WebSphere Server Settings
Input settings for the new WebSphere serverI 9
YWebSphere profile mame: I j

—Server connection type and admin port
{*' RMI (Better performance)

ORE bootstrap port: | 9131
" S0AP (More firewall compatible)

SOAP conmeckar pork: I 8880

[T Rum server with resources within the workspace
[~ Security is enabled on this server

Zurrent active authentication settings:

[sep IO I
Passward; I
Server name: I serverl
—Server type

{*' BASE, Express or unmanaged Metwork Deployment server
™ Metwork Deployment server

metwaork Deplaynient server nanme: I

The server name is in Ehe form af:
=eell mame = =node name =/ =server name =
For example, localfmstocalhostiserver]

Detect | Click this button to detect the server type,

< Back Mext = | | Finish I Cancel

7. Click Finish .

8. The new server should be seen in the Server view.
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-,

ebSphere Process v6.0 Server @ mvsoocrip.ral...

mysxxx.rip.raleigh.ibm.com

Prcperﬁes|Pranems m\c-ﬂnscle| i Ly L =0

Server | Host name | Status | State

E'ﬁu’ebSphere ESE Server v&.0 localhost E\@ Stopped Synchronized
WehSphere Process Server va.0 localhost Eg Stopped Synchronized

Synchronized

support starting remote servers from the Server View.

3

10. From a command prompt, telnet to the remote system if needed:

telnet <HOSTNAME> <TELNET_PORT>"
userid : <USERID>

pw: <PASSWORD>

11. Navigate to the bin directory for the profile being used:

cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin

12. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

13. Wait for status message indicating server has started:

9. Start the remote server if it is not already started. WebSphere Integration Developer does not

ADMU3200lI :
ADMJ3000I :

Server |aunched. Waiting for initialization status

Server cl 1sr01 open for e-business; process id is 0000012000000002
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